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Housekeeping

* This session qualifies for 1 CPE credit.

* Please make sure you sign in on the sheet.

* You must complete the survey through the QR code at the end in
order to receive your CPE certification.

* The survey can be completed using your mobile device. Optional
paper surveys are available and must be turned in at the
registration desk.

* Please silence your mobile device during the presentation.
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Introduction

Lucy Brennan
Project Consultant

e Masters in Business
Administration

e 30 years experience in all levels
of accounting and finance

e More than 15 years of MIP
experience in nonprofit settings
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Session Objectives

Objectives:

* Review Security Rights for Reports

Pre-defined/Default Reports
* Basic Reporting Features

* Process Manager

Additional Tips
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Review Security Rights for Reports

* If you cannot see a report, you don’t " —

have proper rights to see the report

* To change security rights, navigate to -
Security>>Set up Organization Menus e

- Expand Accounting oy L
- Expand Reports X e

- Select Report type you need e
— Set rights on the right hand side L Ot e
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Pre-defined/Default Reports

For a list of predefined reports along with a
brief description:

* Navigate to Help

Pre-defined reports are identified by
brackets “<“ “>”around the report name

* Gives you a starting point for either
processing or modifying a report

* Any change to a predefined report
requires that you give the report a new
name.

* Recommendation is to use the
Copy/Save/Rename icon .

©JMT Consulting. All rights reserved.
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Basic Reporting Features

Navigate to Reports on the menu across
the top of MIP

* Reports are grouped by type

* 5 Standard Tabs on Each Report:
- Setup, Content, Filter, Layout, Security.

* Content on each of these tabs may vary
depending on the type of report.

- Additional tabs may also be present
depending on the type of report.

* Options, Groups, Forecasting

©JMT Consulting. All rights reserved.

Reports Dashboard Organization
Lists

Check/Voucher Register

Journals

Transactions

General Ledger Analysis
Quick Financial Statements
Financial Statements

GASB Reporting

990 Worksheets

Assign Report Groups
Forms Designer

Report Binder

Accounts Payable
Accounts Receivable
Allocation Management
Bank Reconciliation
Budget

Encumbrances

Fixed Assets

Payroll

Purchase Orders

Requisitions

Sec
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Basic Reporting Features

Useful icons:

Copy/Rename

U

* Allows you to make copies or rename
a report

Print Report Setup

* Allows you to select which printer,
number of copies, etc.

Print Setup

* Also allows you to select orientation &

©JMT Consulting. All rights reserved.
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Basic Reporting Features

Useful icons (continued):
Print to Screen
* Allows you to view the report

.‘E-‘,
Print Preview

* Allows you to view the report as it
would be if printed

Print

» Sends report to printer
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Basic Reporting Features

Useful icons (continued):
Export

* Allows you to select the type of file to
export

Export to Excel
Export to PDF

Email Report as PDf

* Email SMTP must be setin MIP

©JMT Consulting. All rights reserved.
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Basic Reporting Features

Setup Tab
* Select the report name whether it is a predefined report or one that a user created.

* Select whether the report name should be printed in the header or the footer of the
report.

* Some Setup Tabs will require date information and more advanced reports will require
format to be selected.

Setup | Content | Filter | Layout | Security |
Report Name
Print Name In Page Footer
(@ Header OFooter (O Do Not Print M induded
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Basic Reporting Features

Content Tab — top portion

Arrange data in report using page breaks

- Move items from the Available box on the left to the Selected box on the right

Setup Content | Filter | Layout | Security |

Items by Page (Optional)
& W *

Avaiabie tems Selected tems Sort Print
at Sequence Segment Name Asc Segment Name - Segment Sequence
ignation Code
orm S30EZ Line Number
orm 9§30 Line Number >
Last Check Number
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Basic Reporting Features
Content Tab — bottom portion
Used to determine which columns appear on the report

Various setting options can be selected for each column such as sort order, show
total, width, wrap, repeat columns and column headings.

Report Body (Total Width: 5.60) +
o W =
Available Columns A Selected Columns Sort Width Show Repeats Wrap Column Heading
Segment Sequence Account Code Asc 1.00 D || Account Code
Account Short Tile Account Title None 2.00 (] ¥ Account Tile
Designation Code Status Asc 1.00 =] ] Status
Designation Description 3 5a Account Type Asc 1,00 [] ~ Account Type
Form S90EZ Line Number .
Form 990 Line Number »

Last Check Number

Reguired Account Assignments «
Stage [
Award Number

Project Director

Award Type

Notification Date
Lrant Dariod Start Data
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Basic Reporting Features

Filter Tab

Use this tab to narrow down and more explicitly specify the data to include in your
report.

Filtering items not selected on the Content tab, the data will not labeled on the
report.

Setup | Content Filter | Layout | Security |

Avaladle Fiter Selected Fiter | Compares To

| Creers 1 | Creers 2 |
Account Type Segment Name | 1| ﬁ |
Status Tithe
ccount Code <Bar>

Stage Cept
Project Drecter Fund
Grant Sponsor
Designation Cod Grant

‘orm 99062 Line Nu moer Progr
Form $90 L mber Restrcton

SE IR B
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Basic Reporting Features

Layout Tab

Allows you to change font, style,

orientation of report

Poge i
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Security Tab

Allows you to prevent changes to report

Setup | Contentl Filter I Layout Security I

Security
[] Do Not Allow Changes to this Report
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Process Manager

Make Sure Process Manager is turned
on under the View Menu.

* Reports Tab

* Expanding sections displays pre-defined reports
as well as newly created reports

Note: Reports listed will change depending on area
of MIP selected in Navigator

©JMT Consulting. All rights reserved.

Process Manager
= Lists

3 Account Code Combinations
# 2 Attachments
= 3 Chart of Accounts
<Accounts by Segment>
J

& 3 Closing Account Assignments

@ 3 Distribution Codes

# 0 Email Templates

#=J Grants

& [ Offset Account Assignments
# 2 Transaction Reports
#'J General Ledger Analysis

. » Favorites

Ed Reérts [ F‘ Forms

Help Links
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Process Manager

Add reports to ‘Favorites’

* Right click on specific report to edit or run the
report or,

* Select ‘Add to Favorites’

This puts the selected report on your Favorites tab
for easy access no matter where you are in the
Navigator!

1 ¢ Favorites jReports | e Forms |

©JMT Consulting. All rights reserved.

Process Manager

23 Lists
3 Account Code Combinations
# O Attachments
= 2 Chart of Accounts
<Accounts by Segment>
@
# O Closing Account Assi¢ Edit
# O Distribution Codes Run
] Email Templates

# 2 Grants Add to Favorites

# [ Offset Account Assignments
-J Transaction Reports
-J General Ledger Analysis
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Any reports added to Favorites tab will be at your

fingertips

Right-click on a report to:

Edit
Run
Rename or

Remove from Favorites

Note: Running a report will run it exactly as the

last time it was saved.

©JMT Consulting. All rights reserved.

Process Manager s -
I Favortes
Chart of Accounts : <GL Segment Name>
Reports - Accounts Payable - Aged Payables : <Aged Payables>
Unposted General Ledger Transactions : Unposted Allocation
Expanded General Ledger : <Expanded General Ledger - This

Month>

Normal Tnal Balance : <Normal Tnal Balance - This Month>
Edit
Run
Rename

Remove from Favorites

L B
% Favorites Z‘lRfDOfts & Forms
Y
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* Organize your Favorites by creating additional folders!

- Right click on the Favorites folder and select Create Folder

 You can also Publish folders to share them to other users

— Right click on the Favorites folder and select Publish Folder

* Other users can import published folders to use shared folders

— Right click on the Favorites folder and select Import Published Folder

*Using the Process Manager can be useful to increase productivity, so users are

not hunting for the correct report to run.
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Additional Tips

* Default reports give you a starting point so you don’t have to format your report
from scratch

* Recommendation is to use the Copy icon and make a copy of a default report

- Any change to a default report, requires that you give the report a new name, in effect J
creating a copy. Y

* Create as many reports as needed. Be sure the report names are easily
recognizable and relate to either how the reports are set up or who created
them.

* On content tab, between top and bottom portion, the Total Width is displayed

— This total includes the space between each of the columns (0.2").

- The minimum column width you can enter for an individual column is 0.1", while the maximum is 7.0".
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Additional Tips
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* If you filter and item that has not been selected in the Report Body on the
Content tab, the data will not appear on the report.

* To filter on a Debit or Credit, you will need to press the dash key prior to entering
a number to indicate a negative amount.

* If the option, Summarize Amounts is selected, the report may not return any
information due to debits/credits are considered detailed amounts.

©JMT Consulting. All rights reserved.
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Filter Operator Criteria Criteria 2
1

Include Funds 02 and 03 | Fund Between 02 03

only Code

Exclude Funds 02 and 03 | Fund Not Between | 02 03

only Code

GL Codes beginning with | GL Code | Like 5% n/a

9

GL Codes not beginning | GL Code | Not Like %5 n/a

with 5

GL Codes beginning with | GL Code | Like 5 234 |nl/a

5, any number in second

position, followed by 234

GL Codes not beginning | GL Code | Not Like 5 234 |nl/a

with 5, any number in

second position followed

by 234

©JMT Consulting. All rights reserved.
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Additional Tips

©JMT Consulting. All rights reserved.
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Reports can be open multiple times, so more than one report can be set up and/or printed at the
same time.

By default, the Clear Fields on Save option is selected on the Options>Customize Workstation
Settings>Preferences tab. When you are running reports, you may want to clear this option. If you
do not, each time you save the report, you will need to reselect the Report Name from the drop-
down list on the Setup tab.

When processing very large reports, select the "Generate Large Reports to Disk Before Viewing or
Printing" option using the Options>Customize Workstation Settings>Reports tab. The reports are
temporarily stored until closed, instead of using up memory.

If you change printers, the orientation of your existing reports may need to be changed. For
example, if you have a report setup with an orientation of landscape, and you install a new printer,
the next time you run the report, you may need to reset the orientation from portrait back to
landscape.
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